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Introduction

Maintenance is an activity which aims at minimizing the incidence of production stops caused by the 
need for repair of broken equipment.    It also extends the economic life of the equipment maintained 
through this activity.

Maintenance is NOT a repair activity - it takes place before the need for repair arises.    However, 
whenever repair of broken down equipment must be carried out, carefully    kept maintenance and 
repair records serve to improve the activities of maintenance.

Keeping of appropriate maintenance and repair records therefore serve to enhance the productivity 
of the industrial plant.    Combining the information in these records with equipment inventory data 
facilitate making of decisions as to when equipment should be replaced and new items purchased.

This is where MPM comes in - to help you with preventive maintenance.

What MPM is

MPM is short for Maintenance Planning and Management.    It is a tool for planning and management 
of    the maintenance activities of an industry of any kind that uses equipment to produce its output.    
It can be applied to industry of any size, although it was essentially designed with medium sized 
industry in mind.

How MPM works
General
MPM has three main functions:

It keeps track of your maintenance activities,    repair and downtime records and warns you when a 
maintenance activity is due;
It keeps a spare parts inventory for you, with current inventory, reorder level and quantity to order;
It keeps a database of equipment and spare parts suppliers.

Maintenance
The principle of MPM is very simple:    First you assign inventory areas to your system, based on the 
location of the equipment.    Then you fill in on-screen 'cards' for inventory, maintenance and repair 
data.    This will be your database for your maintenance planning and management activities.    MPM 
will then provide a daily listing of what maintenance activities need to be carried out and display, print 



or file records for the maintenance and repair work done,    including downtime,    for future reference.

You can also attach short memos to your repair and downtime records or job instructions for each 
maintenance activity.

Spare parts inventory
You complete a 'card' for each spare part, with information on price,    what equipment it is used for, 
the inventory level, reorder level and quantity to order.    You can use this database to search for 
spare parts for a given item of equipment, for equipment that uses that part or to manage your spare 
parts inventory.

Supplier's database
There is again a 'card' for each supplier with his address, phone, fax and telex.    In addition it 
includes information on which of your equipment he delivers and what spare parts.    In addition to 
managing this database and retrieving information about suppliers, it can also be used for searches. 
Thus,    it helps you find the suppliers of a certain item of equipment or a spare part.

The data

The data is stored in a total of six files.    They all have the same name, but different extensions.    For 
instance, if your file name is "MYDATA", the set of data is

MYDATA.MP1    - This contains information on inventory areas
MYDATA.MP2    - Here, you will find the equipment inventory data
MYDATA.MP3    - Contains the maintenance data
MYDATA.MP4    - Stores the repair and downtime records
MYDATA.SPS    - This has the spare parts inventory data
MYDATA.SUP    -    Stores the information on suppliers

System requirements
Hardware requirements
Personal computer using 386 type microprocessor or higher (486 type or higher recommended).
4 MB of memory (8 MB recommended).
EGA, VGA, Super-VGA, XGA, 8514/A or compatible video card with corresponding monitor.
Mouse

Software requirements
Microsoft DOS version 3.1 or higher.
Microsoft Windows version 3.1 or higher.    The program will work with version 3.0, but certain help 
features may not be available.

Licensing agreement
Copyright
The program and related documentation are provided under copyright and protected by international 
copyright treaties and applicable national laws.    The author, Börje Kyrklund, is the sole owner of the 
software.

Operating license
You may also move the software from one computer to another, as long as there is no possibility of it 
being used at one location while it is being used at another.    You may not decompile, disassemble, 
reverse engineer, modify or translate the program or its documentation.    You may not attempt to 



unlock or bypass any copy protection utilized with the program.    You may not remove or modify any 
copyright notice in the program or its documentation.

Distribution license
Although the unregistered, shareware version of the program could be copied freely and distributed 
as long as no charge was made for this, except to cover reasonable costs of distribution, the 
registered version must not under any circumstances be copied for distribution.

Backing-up and transfer
You are authorized to make archival copies of the software for the sole purpose of backing it up and 
protecting your investment from loss.    You may transfer the program to another party only if the 
other party agrees to the terms and conditions of the agreement, and sends the registration 
information to the author.    If you transfer the program, you must also transfer the documentation and 
either destroy or transfer all copies of the program and its documentation.

Terms
This license is effective until terminated.    You may terminate it by destroying all copies of the 
program and its documentation.    This license is also terminated if you fail to comply with any of the 
terms and conditions of the agreement.

Limited warranty

This program is provided "as is", without representation or warranty of any kind, either express or 
implied, including without limitation, any representation or endorsement regarding the use of, the 
results of, or the performance of the program, its appropriateness, accuracy or reliability.      The 
entire risk as to the use of this program is assumed by the user.    In no event will the author be liable 
for any damages, direct or indirect, incidental or consequential, resulting from the use of this 
program.

Using MPM

Getting started
The screen background

The screen as you see it when the program starts shows, after the credits, the opening menu and a 
background picture.    If you get tired of the background, you can double-click on it and the picture will 
disappear.    Instead, you will see a uniform colour background.

To get the picture back, double-click on the background.

Maintenance and repair records
Principle
MPM provides listings of inventory, maintenance and repair data.    These can be displayed on the 
screen, printed or saved to a file.



Display on the screen obviously serves the purpose of allowing a quick look at the status of the 
inventory, maintenance or repair data.    Printouts or filed data, however, are more meaningful as a 
means for future reference.

Establishing maintenance records
Records of maintenance or repairs can be established by printing or filing the corresponding listing at 
regular intervals.    For instance, if    the maintenance listing is filed once every two weeks in a new 
file, there will be a record of all maintenance activities carried out between the dates of two 
consecutive files.

The period between two sets of records depends on how often the most frequent activity is 
undertaken and how important it is that records of such activities are kept.    It may even be 
necessary to file or print records every day or week.    Nevertheless, a likely frequency of recording 
data in this way is once a month.

Establishing repair and downtime records
The repair/downtime card includes five records of repairs or downtime.    In the long term this will not 
be sufficient.    Saving repair and downtime record listings from time to time in a file or as a printout 
accordingly provides a means of expanding the historical repair and downtime data.

By saving the repair and downtime records, say once every six months or once a year, the cards can 
be updated to include only the most recent records.    How often records need to be saved in this way 
depends mainly on how often the    cards get full.

Reports and listings
General
The program produces a number of reports and listings on inventory, maintenance, repair and 
downtime, maintenance due, spare parts inventory and suppliers.    These can usually be displayed 
on screen, printed or filed.

Display report or listing
The option Display leads to    an on-screen listing.    This is in the form of a sort of spreadsheet.    If a 
column is too narrow to display all the text, you can widen it by pointing with the mouse at the 
junction between two columns in the frame at the top, pressing the left mouse button    and "dragging' 
the column limit to the right.    To view different parts of the display, use the scroll bars for horisontal 
and vertical movement.

When you are finished with the display, click on the button shown on screen.

Print report or listing
Clicking on the option Print displays the printer control dialog box.    Make sure that the page setup is 
"landscape" because most of the listings are quite wide.    In the case of supplier data, the printed 
version contains less information about suppliers than the displayed and fired versions, because of 
space problems.

File report or listing
File displays a file save dialog box.    The extension is already given, and you only have to add the 
actual file name, once you have selected the path for filing.    The default path is the directory where 
you have MPM.

Once you have saved the file, you can view it by selecting Notepad from the Utilities option in the 
opening menu.



Converting data format

To convert the data format from that used in Version 1.xx to the new one, select File conversion 
1.xx to 2.xx from the Utilities menu.    You will then be prompted for 

The path and the name of the series of data files for Version 1.xx

For instance, it could be

                                    C:\OLDMPM\OLDDATA

Please note that no extension is included, since it refers to several files.
The path and the name of the new series of data files for Version 2.xx

For instance, it could be

                                    C:\NEWMPM\NEWDATA

Again, do not include any extension in the file name

After that, the program takes over and converts the data.    If there are any problems, it will let you 
know.

The new data format is very simple.    It is    a set of text files, with one line for each    data item.    This 
gives the advantage that it is easy to check the correctness of the data if necessary.    Any 
irregularities, once identified, can easily be corrected, using the Notepad provided under Utilities.    
However, do not do it unless you are confident that you know how to do it.    For more serious 
problems, contact Technical support.

Setting up    your maintenance system

Before your start setting up your system for maintenance, think it through carefully.        For instance, 
how is your equipment distributed over different departments?    Is some equipment in    other 
locations?

Therefore,    the first thing is to divide your equipment inventory into easily identifiable blocks or 
'areas'.    MPM has some default areas, such as 'Field', 'Office',    'Process' and 'Warehouse', but you 
may want to use entirely different ones.

You also need to think about how you are going to code items in your equipment and spare parts 
invetories.    The code for each item must be unique, since the program uses these codes for 
searches.

Once you have defined your areas and codeing system you are ready to go.    So, click on New in 
the File menu to clear the memory and start afresh.    This also activates the menu Main options, so 
that you can access them.

Very often people expect to see something happen when they click on New.    However, apart from 
activation of menu options, nothing visible happens.    You have not done something wrong or the 
program has not stopped responding.    Things start happening when you begin manipulating your 
data or creating your data.



Now - click on Main options and select Maintenance.    This displays another menu - your 
maintenance menu.

Establishing maintenance, repair and downtime 
records
Principle
MPM provides listings of inventory, maintenance and repair data for each selected inventory area.    
These can be displayed on the screen, printed or saved to a file.

Display on the screen obviously serves the purpose of allowing a quick look at the status of the 
inventory, maintenance or repair data.    Printouts or filed data, however, are more meaningful as a 
means for future reference.

Establishing maintenance records
Records of maintenance or repairs can be established by printing or filing the corresponding listing at 
regular intervals.    For instance, if    the maintenance listing is filed once every two weeks in a new 
file, there will be a record of all maintenance activities carried out between the dates of two 
consecutive files.

The period between two sets of records depends on how often the most frequent activity is 
undertaken and how important it is that records of such activities are kept.    It may even be 
necessary to file or print records every day or week.    Nevertheless, a likely frequency of recording 
data in this way is once a month.

Establishing repair and downtime records
The repair/downtime card includes five records of repairs or downtime.    In the long term this will not 
be sufficient.    Saving repair and downtime record listings from time to time in a file or as a printout 
accordingly provides a means of expanding the historical repair and downtime data.

By saving the repair and downtime records, say once every six months or once a year, the cards can 
be updated to include only the most recent records.    How often records need to be saved in this way 
depends mainly on how often the    cards get full.

Changing inventory areas
List areas
Whether you want to add or delete an inventory area, click on the 'Area' menu option in the 
maintenance menu.    This displays choices for listing, adding or deleting areas.    Click on 'List areas' 
to obtain a listing of the areas used by the program.

Add areas
To add one or several areas, click on 'Add area' and type the name of the new area you want to add 
to the list. Click on 'OK' .    Repeat this until you have added all the areas you intended to add.

Delete areas
You can delete areas one at a time by clicking on 'Delete area'.    This displays a listing of the areas 
used by the program.    Move the cursor bar to the area you want to delete and click on 'OK'.

Creating new maintenance data



New maintenance data cards
To create new data cards, click on New under the    Inventory option in the maintenance menu.    
This displays a listing of the areas you have defined.    Select the area for which you are going to 
start inputting data and the program displays an empty 'Inventory card'.    The first input box has 
already been completed with the area you just selected.

Press the [TAB] key which brings the vertical cursor to the window for entry of an inventory code.    
Please note that    the inventory code is used by the program for sorting of data.    Accordingly the 
code must be unique to each particular item of equipment.

Enter an inventory code.    If the code entered is already in use, the program will alert you to this and 
ask you to correct the code.    Press the [TAB] key again and enter the information requested in each 
case until the inventory card is completed.    Click on 'OK' or press [ENTER].

A 'Maintenance card' will be displayed.    The top half has already been completed by MPM, based 
on the information in the inventory card.    Again, use the [TAB] key to move around between the 
entries and enter the data requested.    You can enter today's date in the input boxes for "Last" by 
double-clicking on those boxes.    Please note that you do not need to enter the date of the next 
maintenance due in each case.    This will be added by the program afterwards. To the right in each 
row is a tick box.    If you want to include job instructions, click on the tick box and in the dialog box 
that follows, enter the name of the text file where the job instructions are. Click on 'OK' or press 
[ENTER] to get back to the maintenance card.    There is now an exclamation mark next to the text 
box. Click on 'OK' or press 'Enter' when finished with that card.

On entering dates, use consistently the date format you have set up in Windows.    The program 
assumes that you use the same format.    Otherwise it will not recognise the dates as valid ones, and 
it will refuse to accept your inputs.

Since the database is being established, it is unlikely that there would be any repair or down time 
records to add to the 'Repair card' at this stage.    Otherwise the procedure is the same as for the 
inventory and maintenance cards.    Press [ENTER] or click on 'OK'.    One set of data has now been 
added to your database. You can also add short memos to each repair event, by clicking on the tick 
box in the same row.    This opens a memo window, where you can add up to 255 characters.    Click 
on 'OK' when you have finished to return to the repair and downtime card.    There is now an 
exclamation mark next to the tick box to show that a memo has been added. 

If you have second thoughts before you have finished the whole data input sequence, just click on 
'Cancel' and the program will ignore all inputs you have made in that sequence.

When you have finished you inputs, click on Go back in the maintenance menu.    That will bring you 
back to the main or opening menu.

New data for spare parts and suppliers
Spare part data
From the main menu click on Main options and select Spare parts.    This opens the spare parts 
menu.    There, click on Spares and select New.    That displays a spare parts inventory 'card'.    Use 
the [TAB] key to move around between the different input fields.    Complete the requested 
information.    Please note that the spare parts inventory code, different from the equipment inventory 
code, must be unique. 

When you have finished, click on 'OK' or press [Enter].    Repeat until data for all spares have been 
recorded.    Then click on Go back to get to the main menu.



Supplier data
From the main menu click on Main options and select Who supplies?.    This opens the supplier 
menu.    There, click on Supply and select New.    That displays a supplier's data 'card'.    Use the 
[TAB] key to move around between the different input fields.    Complete the requested information. 

When you have finished, click on 'OK' or press [Enter].    Repeat until data for all spares have been 
recorded.    Then click on Go back to get to the main menu.

Saving your work
Save as...
Use this option in the File option in the main menu when you have started a new database or if you 
want to save your work in a set of files separate from the work included in the one you originally 
loaded into the program.    For    a new set of data, this is the save option you will get to automatically, 
since the data have not yet been assigned to a set of files.

A dialog box will display the default directory of files with the extension '*.mp1'.    If you want to store 
the file in a different directory, double-click on the symbol for the root directory (for instance, c:\) until 
the directory of your choice is displayed. 

Double-click on the name of your choice for the file, if it is an existing file, or type a name for your file, 
without extension.    MPM will add the extension for the set of files stored under the name or your 
choice.

Loading data
Loading the data
To load existing data already saved in a file, click on 'Open' under File    in the main menu.    If the 
dialog box does not display the directory in which you have stored the data, double-click on the root 
directory symbol until the directory is displayed and select it by double-clicking.

Select your data file from the list of files and click on 'OK' to load the data.    This will load four files 
with the same name and the extensions *.mp1, *.mp2, *.mp3,    *.mp4, *.sps and *.sup.

A message will display quickly, confirming that data have been loaded and telling you that you should 
use the menu options to access them.    At the top of the screen you also see the name of the set of 
files that has been loaded.    Otherwise the screen looks as before.

Note: There are two sets of example data included in the package.    One set (Example1) for those 
using a date format of dd/mm/yy and another (Example 2) for those using mm/dd/yy.    To avoid 
confusion, you will see a message to that effect briefly each time you load data.    In the registered 
version it will disappear for ever three days after the installation of the program.    In the shareware 
version, however, it will remain.

Menu commands

Opening menu

The opening menu has    for options:

File.    This includes, in addition to choices for opening and saving files, choices for changing the 



fonts in reports, printer setup and, of course, "Exit"
Main options. This is the centre of operation of MPM.    Here you select between maintenance 
management, spare parts inventory and the supplier database.
Utilities.    These include, most important, a utility for converting MPM Version 1.xx data to Version 
2.xx data format, a notepad for reading and editing text files and a calculator.
Help. Here you will find all information you need about MPM.

The Main options menu choice is not activated when you start.    To activate it, you need to either 
select    New or load filed data (Open) from the File menu.

If you have previously used version 1.xx of MPM and already have data for your maintenance 
activities, you should start by selecting    File conversion 1.xx to 2.xx    from the Utilities menu.    
This will convert your data to the new format used by MPM Version 2.0.

Maintenance menu

There are seven main options in the maintenance menu:

Go back that takes you back to the main or opening menu;
Area which gives you selections for List areas, Add area and Delete area;
Inventory with selections for
-    New, to open a new inventory card for new input
-    Select/Edit, to open an existing inventory card for viewing, editing and deleting.    This is also 
used to select a set of cards for inventory, maintenance and repair records that can only be 
accessed once this selection has been made.
-    Inventory listing, that gives three options for the list of inventory items: Display, Print and File.
Maintenance with options for
-    Card to view, edit or update a maintenance card.    The item must first be selected under the 
Inventory and Select/Edit
-    Report with three options for Display, Print and File
Repairs/Downtime. The options here are
-    Card to view, edit or update a repair and downtime data    card.    The item must first be selected 
under the Inventory and Select/Edit
-    Report with three options for Display, Print and File
To do, that gives a listing of maintenance activities due.    The options for the listing are Display, 
Print and File.
Help that gives access to the help features of this program

Spare parts menu

The are four main options in the spare parts menu

Go back that takes you back to the opening menu or main menu.
Equipment with options for
-    List spares for equipment.    This gives you an on screen listing of all spares in the inventory that 
are used for a selected item of equipment
-    Find spare for equipment.    That helps you retrieve a spare parts inventory card of a part for a 
given item of equipment
-    All equipment gives you an on screen listing of all equipment in the inventory, with data.
Spares with options for 
-    New for a new spare parts inventory card for fresh input
-    Find spare/Edit to retrieve a spare parts card for viewing, editing or deletion.    The option here 
are to Search by item    or to Search by code
-    All spares that gives a listing of all spare part in the inventory.    The options here are Display, 



Print and File
-    Equipment using spare.    This gives a listing with data of all equipment that uses a spare parts 
item.
Help with access to the help features of this program

Supplier menu

There are four main options for the supplier menu:

Go back that takes you back to the opening menu or main menu.
Suppliers with options for 
-    New to access a new supplier data card for fresh input
-    Select/Edit for retrieving a supplier data card for viewing, editing or deletion
-    Supplier addresses with three options for Display, Print and File.    Please note that because of 
restrictions imposed by paper page sizes, the information in the printed version is less complete than 
in the displayed or filed versions.
Equipment with a selection for Equipment supplier.    This finds the supplier of a given item of 
equipment.
Spares with a selection for Spares supplier.    This finds the supplier for a given spare part.
Help with access to the help features of this program

Procedures

Equipment inventory card
New data input
When a new equipment inventory card is displayed, the first input field has already been completed 
for you - the area where the equipment is, for inventory purposes. The second field is the inventory 
code for the item of equipment and the third is the name of the item You must assign a unique 
inventory code to the item and its name should also be unique.    Both of them are used as a 
reference in searches and in manipulating data.

If you have several identical items of equipment in your inventory refer to them as "Widget puncher 
1", " Widget puncher 2" and so on.

If you leave the code or the name blank or if you use codes or names already in use, the program 
will refuse to accept the input and tell you so.

The subsequent input fields are quite simple to complete and there are no special consideration as 
regards them.

Editing and deleting
When you display an equipment inventory card from your database, and click on "OK", there will be 
no change, unless you have edited the card by changing the inputs.    In that case, your    database 
will be changed accordingly.    If you change you mind about editing the data, just click on "Cancel", 
and the program will ignore your changes.

If you click on "Delete", the program will delete all inputs on that item from the database, including 
the maintenance card and the repair and downtime record.    It will still retain reference to the item of 
equipment in the spare parts and supplier data.



Maintenance data card

The maintenance data card can only be displayed in two ways.    Automatically on    input of a new 
set of data for inventory, maintenance and repairs or by first selecting the corresponding equipment 
inventory card.    After that you may call the Card from    the options under Maintenance in the 
maintenance menu and display the maintenance card for the item of equipment.

When the card is displayed, the program has already filled in the first three input fields on the card: 
area, inventory code and name of the item.    What remains is to complete the fields for each 
maintenance activity, how often it should be done (expressed as days between maintenance) and 
when it was last done.    Use the same date format as you have defined it in your Windows setup.    
You do not need to input the next date when maintenance is due.    The program will do it after you 
are finished inputting data on the card.

To the right in the row for each maintenance activity, there is a little tick box.    Clicking on that 
displays a dialog box with the name of the item of equipment, the maintenance activity    and the 
name of the text file, where you have written instructions for how the maintenance job should be 
done.    These instructions can be written with any ACSII text editor outside the program or using the 
editor of the program by clicking on the "Editor" button.    To add an existing file to the set of data, 
either write the name of the file in the input window or click on 'Browse' and select the file from the 
directory display.

If you include the file name for the job instructions, there will be an exclamation mark next to the tick 
box in the maintenance card.

Maintenance job instructions
New instructions
Clicking on one of the tick boxes to the far right of the maintenance card displays the dialog box for    
job instruction file details.    If no job instruction is yet included and there is a need for one, click on 
"Edit".    This displays a text editor with a file TEMPLATE.TXT displayed.    Fill in the information listed 
at the top and start writing the instructions.

When you have finished, click on    File|Save As and give the file an appropriate name, with the 
extension ".TXT".    Click on File|Exit to leave the editor and get back to the dialog box.    Write the 
name of the file in the field "Name of job description file" and click on "OK". This closes the job    
description dialog box and returns you to the maintenance card.    There is now an exclamation mark 
shown to the right of the tick box for that activity, to show that a job description is attached.

 Note: Do not click on Save, because that saves the job description file as "TEMPLATE.TXT".

Viewing, editing and printing
When the dialog box for job instruction file details is displayed the field for "Name of job instruction 
file" is empty, unless you have already attached one.    Clicking on the "Edit" button retrieves the 
editor with the text of    the job description file displayed.      You can view it on screen and make any 
changes you want, then click on File|Save to save the changes.

To get a printout of the job description to give to the maintenance worker, click on File|Print.

When you have finished, click on File|Exit.    This brings you back to the dialog box for job instruction 
file details.    Clicking on "OK" brings you to the maintenance card that you close by clicking on "OK".

Repair and downtime card



The repair and downtime card can only be displayed in two ways.    Automatically on    input of a new 
set of data for inventory, maintenance and repairs or by first selecting the corresponding equipment 
inventory card.    After that you may call the Card from    the options under Repair and downtime in 
the maintenance menu and display the repair and downtime card for the item of equipment.

When the card is displayed, the program has already filled in the first three input fields on the card: 
area, inventory code and name of the item.    What remains is to complete the fields for each of the 
repair and downtime records.    The input fields for "Problem" and "Action take" may seem small for 
any meaningful input.    However, the information wraps line after line which can be viewed by 
clicking on the up or down arrow to the right of each of these input fields.    You can accordingly input 
a fair amount of information in these - up to 255 characters.

To the right of each row of repair of downtime events there is a tick box with the heading "Memo".    
Clicking on one of them gives you access to a small memo screen, where you can make comments 
and write additional information    on the repair and downtime event.    If a memo has been included, 
there is an exclamation mark next to the tick box of the corresponding    repair and downtime event.

Memos for repair and downtime data

The memo for each repair and downtime event can be a maximum of 155 characters long.    The 
dialog box for this input therefore displays a character count as you write.    If you try to close the 
dialog box by clicking on "OK" and the count is over 155 characters, you will get an error message 
and the input will not be accepted.

When you have finished writing the memo, click on "OK".    this will return yo to the maintenance card 
which now has an exclamation mark added to the right of the tick box for the repair and downtime 
event.    This indicates that a memo is included.

You can subequently view and edit the memo by clicking on the tick box.    However, you cannot print 
it.    To do that, you can block the text with the mouse,    click on it with the right mouse button and 
copy the highlighted text to the clipboard.    You can then call the Notepad in the Utilities option of 
the opening menu. Click with the right mouse button and paste the text onto the notepad. From 
there, you can print the text by clicking on File|Print in the Notepad menu.

Viewing editing and deleting maintenance data

For viewing editing and deleting maintenance data, the only access to them is through Select/Edit in 
the Inventory option of the maintenance menu.
This shows the inventory card, once you have made the appropriate selection of an item of 
equipment in the dialog boxes.    You can then view and edit any item, except the inventory code and 
the name of the item in that card.    To delete a set of data, click on the "Delete" button.    This will 
remove all data for that item of equipment, including data on maintenance and repair and downtime 
records.

Once you have closed the inventory card by clicking on "OK" or "Cancel", you can access the cards 
for maintenance and repairs for that item.    To do this, click on Card in the    Maintenance or in the 
Repair and downtime    options. You can then edit them, except the entries for inventory code and 
name of the item.    If you have carried out a maintenance activity 'today', you can enter today's date 
in the "Last" input box for that activity by double-clicking on it. If you change your mind and want to 
keep the entries as they were, click on "Cancel".    Other click on "OK" when you have finished 
editing. This will store your new entries.



Spare parts inventory card
New card
In the spare parts menu, click on New in the options for Spares.    This gives you a blank card to 
complete.    Here again you need a spare parts inventory code which is different from the ones you 
used for equipment.    Like the equipment inventory code, the it must be unique.    The same applies 
for the name of the spare part.

The "Spare part code" is the manufacturer's code number for the part and has nothing to do with 
your inventory codes.    "Use" is the inventory codes(s) of items of equipment that the spare part is 
used in, separated by a comma, if there are more than one item.

"Stock"    is the number of items in the current inventory.    "Order at" is the stock level (reorder level) 
at which a new order should be placed.    "Quantity" is the number of items that should be ordered 
each time (quantity to order).

Viewing, editing and deleting
A spare part card can be accessed in several ways, using the various search alternatives for spare 
part inventory information.    The simplest is if you know the name of the part.    Just click on Find 
spare/Edit in the Spares option of the spare parts menu and select Search by item.    A dialog box 
appears that lists all spare parts in the inventory.    Select the one you want and the corresponding 
card is displayed.

You can edit all the inputs, except the inventory code.    When you have finished editing, click on 
"OK".    That saves the changes you have made.

To delete a spare part card, click on "Delete".    That deletes all information about that spare part.

Viewing editing and deleting spare parts data

See 'Spare parts inventory card'.

Supplier data card
New card
To complete a new card, click on New in the Suppliers option in the supplier menu.    This displays a 
new card.

The    information on suppliers you need to input    in the supplier data card is mostly obvious, like 
name, address, phone, etc.    What is important here is that the name must be unique, which it 
usually is.    The only other items that may require some explanation are "Equipment codes" and 
"Spare parts codes".

In "Equipment codes" you input the inventory codes for equipment that the supplier has. In "Spare 
parts code" you input the codes for the spare parts he can deliver.    In both cases each code should 
be separated by a comma.

There may not seem to be much space for input of the these codes.    However, the information is 
wrapped on several lines that can be viewed by clicking on the up or down arrow next to the input 
field.    The limit is a total of 155 characters.    Assuming your code has four digits and adding a 
comma, this gives you space for 31 inputs in each.    If that is not enough, you can start a new card 
for the same supplier.    In that case you must give him a slightly different name.    If the name is 



"Joe's Junkyard", you call the supplier on the additional card "Joe's Junkyard 1" and so on.

Viewing, editing and deleting
An existing supplier card can be accessed in several ways, using the search features of the program. 
However, if you know the name, the simplest way is perhaps to click on Select/Edit in the Suppliers 
option in the supplier menu.    Select the name of the supplier.    The opens his data card.

You can edit any of the information in the card, as required.    When you have finished, click on "OK". 
That saves the new information.    To delete a    card from the database, click on "Delete".

Viewing editing and deleting supplier data

See 'Supplier data card'.

Maintenance activities due

MPM will warn alert you    about maintenance activites three days before they become due.    After 
that it stays on your "To do" list, until you have carried out the task and registered it with the program. 
If    you do not do the maintenance in time, the list will point out that it is overdue.

Click on    To do in the maintenance menu and select whether you want the listing displayed on 
screen, printed or filed.

Finding equipment that uses spare part

Click on Spares in the spare parts menu and then on Equipment using spare.    This displays a 
dialog box with a list of spare parts, by name.    Select the one of interest to you.    You then have a 
display of all inventory information on all items of equipment that use the spare part you selected.

Finding a spare part
General
The search for information on a spare part can be done in several ways.    There are two choices for 
this in each of the Equipment and Spares options in the spare parts menu.    Your choice between 
the ways you search for the information on the part depends on what you know about it and what 
you want to know..

Equipment option
Click on List spares part for equipment.    Select the inventory area and the item of equipment from 
the subsequent dialog boxes.    This gives you a listing of all information on spare parts that are used 
for that item of equipment.

Click on Find spare for equipment.    Select inventory area and item of equipment from the next two 
dialog boxes.    You then see a dialog box with the name of the item of equipment and a listing by 
name of all spare parts used for that item.    Select the spare part for which you want information.    
This displays its spare part card.

Spares option
Click on Find spare/Edit.    This gives you two choices:



Search by item.    Use this if you know the name of the spare part.

Search by code.    Use this if you know the inventory code of the spare part.

Finding supplier of equipment

Click on Equipment and Equipment supplier in the supplier menu.    Then select the inventory area 
of the item.    From the subsequent dialog box, select the item of    equipment.    Form the dialog box 
that shows a listing of suppliers for that equipment, select one.    This displays the corresponding    
supplier data card.

Finding supplier of spare part

Click on Spares and then on    Spares supplier in the supplier menu.    This gives a dialog box with a 
listing of all spares.    From that list, select the spare part you want information on.    Finally , from the 
dialog box with a listing of suppliers of that part, select a supplier.    You then get the corresponding 
supplier data card.

Dialog boxes

A number of commands or activities are controlled by dialog boxes.    These are explained in detail in 
the "Procedures"    topic.    However, there are four commonly displayed buttons for control of the 
dialog boxes.    They are:

"OK".    This accepts any input that has been made to the dialog box and confirms you intention to go 
ahead.

"Cancel" is used if you change you mind and do not want to save the inputs to the dialog box and do 
not want to go ahead.

"Delete" removes the set of information.    In the case of maintenance data, it removes all information 
about an inventory item, including    maintenance and repair data.    For spare parts and supplier 
data, it only removes the set of information displayed on the card.

"Help" displays this screen.

Help on Help

You have access to Help in three ways:    As    a specific menu item in the Help menu, by pressing the 
[F1] key or from the Help button in the dialog boxes.

Help as a menu item
The Help menu has two options for calling Help.    First, 'Help on MPM' which gives you the Contents 
screen of Help.      From this you can access all the other screens and read them as a manual for 
MPM.

Second, there is the 'Help on Help' option, which calls this screen.

Help from F1



Help obtainable by pressing the [F1] key is context-sensitive, that is, the Help screen displayed 
depends on what menu option has been selected before [F1] was pressed.

If no menu selection has been made,    Help displays its Contents screen.    Please note that Help 
cannot be accessed by pressing [F1] when a dialog box is displayed. 

Help for dialog boxes
The only way to access Help when a dialog box is displayed is by clicking on the Help button of the 
box.    This displays the Help listing for dialog boxes

Technical support, etc.

Copyright

Copyright © 1996 Börje Kyrklund.    All rights reserved.

Registration

It is in your interest to register your copy of MPM as soon as possible.    As a registered user, you will 
be notified of future upgrades and you will also have access to technical support.

Registration by mail or fax

In the Help menu, click on 'Print registration form' to obtain a copy of the form.    Complete the form 
and either

send it by mail to:
  
                    Borje Kyrklund
                    Via dei Radiotelegrafisti 28 B 3
                    00143 - Rome, Italy
or fax it to +(39-6) 592-0773.

Note that 39-6 is the IDC for Rome, Italy

Registration by E mail

Click on 'Print registration form' in the Help menu and send the information requested in the form by 
E-mail on Compuserve to Borje Kyrklund, CIS 100013,375 or    on Internet 
100013.375@compuserve.com.

Technical support
Technical support is available by mail, fax and E-mail by stating the serial number of your copy of 
MPM.
By mail:              Borje Kyrklund
                                      Via dei Radiotelegrafisti 28 B 3
                                      00143 - Rome, Italy



By fax:              +(39-6) 592-0773

Please note that (39-6) is the IDC for Rome, Italy
By E-mail:      Borje Kyrklund
                                    Compuserve ID 100013,375
                                    Internet 100013.375@compuserve.com

There is also an Internet home page where you may    find the answer to your questions:

                                              http://ourworld@compuserve.com/homepages/BKyrklund

Glossary
D
date format: The program takes the date format to be used from the Windows setup. If you use a 
different format, the program will be unable to recognise it as a valid date or misinterpret the data.
downtime: The time in hours the equipment has been idle for reasons such as    repair or lack of raw 
material.    Please note that it does not refer to repair alone.
I
inventory area: A defined location, department or subsidiary where an item of equipment is.    It may 
also refer to a group of equipment, such as "Mobile", to indicate that these items are not only in one 
place.    Typical areas would be "Main office", "Laboratory", "Production 1", etc.
inventory code: A unique code assigned to each item of equipment or spare part in the respective 
inventory.
J
job instructions: A document used to instruct the mainteance worker on    how the work should be 
carried out.    It is not needed for all maintenance activities, but it may be    especially important when 
the maintenance work is contracted outside.    It may also be important in the case of very 
infrequently occurring maintenance work.
M
maintenance and repair records: Maintenance and repair records are kept to ensure that 
equipment has been appropriately maintained in the past and to keep track of the need for repairs 
and downtime.
N
name of the item: The name of the item of equipment or spare part must be unique.    If there are 
several identical items in the inventory, give them names like "Widget puncher 1", "Widget puncher 
2", etc.
Q
quantity to order: The quantity of an inventory item that should be ordered when the reorder level is 
reached.
R
reorder level: The inventory level at which an order should be made for new items.    This depends 
i.a. on the delivery time for the item(s) and its price.


